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Abstrakt 

Bakalářská práce se zabývá problematikou výstavby 3D geometrického modelu 

zájmové oblasti. Tato práce je koncipována na dvě části. Teoretickou část, kde je 

teoreticky popsána práce s programy GRASS GIS a GMSH. Jejich výhody nevýhody, 

jaké data používají. Praktická část popisuje práci s geografickými daty a programy 

GRASS GIS a GMSH, aby se dosáhlo hlavního cíle této bakalářské práce, kterým bylo 

vytvoření trojrozměrného geometrického modelu dané oblasti.  

 

Klí čová slova 

3D geometrický model, GRASS GIS, GMSH, geografické data  
 

Abstract 

The bachelor thesis deals with the 3D geometric model building area of interest. 

This work is conceived in two parts. Theoretical part, where are theoretically described 

the work with softwares GRASS GIS and GMSH. Their advantages, disadvantages and 

what data are used. Practical section describes work with geografical data and softwares 

GIS GRASS GIS and GMSH to achieve the main objective of this thesis, was to create 

three-dimensional geometric model of the area. 
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Úvod 
Svět se vyvíjí a technologie s ním. V dnešním uspěchaném světě se lidé snaží o 

rychlou a efektivní práci s co možná nejmenším úsilím. Geografie toho může být 

příkladem. Za stovky let nahradily papír, tužku a hvězdy moderní přístroje, které 

usnadňují práci uživatelům.  

S dnešními možnostmi zpracování geografických dat pomocí počítačů a jiných 

elektronických přístrojů, které usnadňují práci při sběru, zpracování, analýze nebo třeba 

vykreslení geografických dat do nějakého grafického výstupu. Vykreslování 

geografických dat je v takové fázi, že si člověk může vymodelovat potřebný model 

v trojrozměrném pohledu se stromy, domy, infrastrukturou, řekami nebo jezery. Může si 

i dokonce tento trojrozměrný model vymodelovat v závislosti na ročním období a poté 

analyzovat různé jevy na příslušném modelu. 

Tato bakalářská práce se zaobírá výstavbou trojrozměrného modelu zájmového 

 území. Nejprve bylo zapotřebí nastudovat problematiku výstavby geografických 

trojrozměrných modelů, protože jsem se s nimi ještě nesetkal. Poté si zvolit program 

nebo programy, se kterými tuto problematiku vyřeším. Nakonec jsem si zvolil program 

GRASS GIS pro úpravu dat modelované oblasti a program GMSH pro vytvoření 

trojrozměrného geometrického modelu území. Bakalářská práce je koncipována do dvou 

částí. Tou první částí je teoretická část, kde jsou popsány programy GRASS GIS a 

GMSH. Jak se s nimi zachází. Co všechno umí. Tou druhou částí je praktická část, kde 

je vysvětlen postup práce s geografickými daty a programy GRASS GIS a GMSH, aby 

se dosáhlo hlavního cíle této bakalářské práce, kterým bylo vytvoření trojrozměrného 

modelu dané oblasti.  
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1 Teoretická část 

1.1 Co je to GIS? 
 GIS je zkratka ze spojení slov Geografický Informační Systém. Je to informační 

systém založený na elektronickém získávání, ukládání, správě, dotazování, analýze a 

zobrazování prostorových dat. 

 GIS se skládá z mnoha úrovní. Tou nejzákladnější úrovni je využítí pro 

počítačovou kartografii, to jest mapování. Největší předností GISu je využívání 

prostorových a statistických metod pro analýzu atributů a geografických informací. 

Konečným výsledkem z analýz může být odvozená informace, přerušená informace či 

informace seřazená podle důležitosti (Ing. Jitka Jiravová, 2005). Klíčovým slovem této 

problematiky je geografie. To znamená, že data (nebo alespoň některé části dat) jsou 

prostorová. Jinými slovy. Data, která nějakým způsobem odkazují na místa na Zemi. 

Spolu s prostorovými neboli grafickými daty jsou obvykle propojena tabulková data, 

známá jako atributová data. Atributová data lze obecně definovat jako další informace o 

každém z prostorových prvků. Příkladem toho by mohla být například autobusová 

zastávka. Autobusová zastávka je prostorová souřadnice, k niž se vztahují další 

informace, jimiž jsou atributová data. Jako je například název zastávky, které autobusy 

staví na této zastávce. A dále umožňuje synchronní práci mezi nimi, tedy mezi 

prostorovými a atributovými daty. 

 GIS je složen ze čtyř základních částí neboli komponent, kterými jsou lidé, data, 

hardware a software. Lidskou komponentou je člověk, který umí zacházet se zbývajícími 

komponentami a rozumí jim natolik, aby práce s nimi byla rychlá a efektivní. Data jsou 

základním kamenem a často bývají tím nejdražším. Získávají se z papírových map, 

souřadnic, GPS modulů a digitálních dat. Pod pojmem software se ukrývají programy, 

které umí data otevřít, dále s nimi pracovat a tím usnadňovat práci a šetřit čas. Zástupci 

těchto programu jsou například Grass GIS, ArcGIS, Quantum GIS. Hardwarem se 

rozumí vybavení potřebné k tomu, aby podporovalo činnosti GISu v rozsahu od sběru 

dat až k analýze dat. Tímto vybavením by mohlo být například GPS zařízení pro sběr 

dat, digitizér pro konverzi papírových dat do digitálních dat, počítač s potřebným 

softwarem, aj. 
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1.2 Grass GIS 
 

 GRASS (Geographic Resources Analysis Support System) je geografický 

informační systém (GIS) pro správu, analýzu, zpracování obrazu, prostorového 

modelování a vizualizaci prostorových dat. Tento program je široce používán v 

akademickém i komerčním prostředí po celém světě, stejně jako v mnoha státních 

agenturách. Výhodou tohoto programu je, že se jedná o tzv. free software (volně 

šiřitelný) publikovaný pod licencí GNU General Public License (GNU GPL) (Markus 

Meteler, 2005). Umí pracovat pod nejrozšířenějšími systémy na světě, kterými jsou 

Windows, Linux a Mac. Další výhodou tohoto programu je jeho obsáhlost. Má v sobě 

zakomponováno více jak tři sta padesát modulů, které si poradí s většinou vašich 

požadavků. GRASS využívá jak intuitivní grafické uživatelské rozhraní, tak i příkazové 

okno, ze kterého se mohou ovládat veškeré potřebné operace. Atributová data jsou 

většinou spravována ve vektorových souborech DBF nebo v SQL databázových 

systémech (DBMS). Nviz je modul pro vizualizaci rastrových dat a 2D/3D vektorových 

dat. GRASS má v sobě plně integrované knihovny GDAL / OGR na podporu široké 

škály rastrových a vektorových formátů. 

 

1.2.1 Geografická data 

 

 Rastrová data 

 Rastrová data jsou abstrakcí skutečného světa, kde data jsou vyjádřena jako 

prostorové matice buněk nebo pixelů. Každá oblast dat je rozdělena do řádků a sloupců, 

které tvoří pravidelnou mřížkovou strukturu. Každá buňka musí být obdélníkového 

tvaru, ale ne nutně čtvercového. Každá buňka v této matice obsahuje místo souřadnice, 

stejně jako hodnotu atributu. Prostorové umístění každé buňky je implicitně obsažena v 

pořadí matice. Rastrová data jsou vhodná zejména pro určité typy prostorových operací, 

například pro překryty nebo plošné výpočty. Nevýhodou rastrových dat je jejich 

nepřesnost zobrazení zakřivených ploch v závislosti na rozlišení (Geodatabases 

Explored, 2000). 
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 Vektorová data 

 Vektor je datová struktura sloužící k ukládání prostorových dat. Vektorová data 

se skládají z bodů, linií, oblouků a polygonů, které začínají a končí v uzlech. Umístění 

těchto uzlů topologické struktury je obvykle uloženo napřímo. Každá z těchto jednotek 

se skládá pouze jako série jedné nebo více souřadnic. Například linka je sbírka 

souvisejících bodů a polygon je soubor příbuzných linií (Geodatabases Explored, 2000).  

 

1.2.2 Prostředí programu Grass GIS 

 Od roku 1998 je tradiční textová konzole doplněna novým grafickým 

uživatelským rozhraním založeným nejdříve na jazyku Tcl/Tk poté na platformě 

wxGUI. Tím vzniklo jednoduché grafické rozhraní, které je na platformě nezávislé. Toto 

rozhraní umožňuje uživatelům rychle a jednoduše importovat, prohlížet a zpracovávat 

data. Všechny hlavní moduly, přítomné v GRASSu, jsou přístupné z nového grafického 

rozhraní. Rozhraní se skládá z jednotlivých oken sloužících k zadávání vstupních údajů, 

čímž je uživatelům zpřístupněna plná funkcionalita GRASSu. 

  

1.2.2.1 Grafické uživatelské rozhraní 

Grafické uživatelské rozhraní slouží k rychlému intuitivnímu zadávání příkazů za 

pomoci myše. Bohužel nelze spouštět všechny moduly a funkce skrze grafické 

uživatelské prostředí, které GRASS GIS obsahuje.  

Při spuštění grafické uživatelské rozhraní GRASSu se otevřou dvě základní okna, 

kterými jsou Správce vrstev v angličtině Layer Manager a Map display. 

 

Správce vrstev (Layer Manager)  

Správce vrstev slouží k tvorbě, zobrazování a následné editaci jednotlivých 

vrstev. Ve Windowsovském Správci vrstev je menu s řadou vysouvacích záložek pro 

funkce GRASS GIS. Na obr. je umístěno nejvýše a obsahuje záložky s názvy Soubor, 

Nastavení, Rastr, Vektor, Obraz, 3D rastr, Databáze a Nápověda. S těmito záložkami se 

dá ovládat něco kolem dvě stě padesáti modulů a funkcí za pomoci grafické uživatelské 

rozhraní. Pod tímto menu se nachází Toolbar s třinácti ikonami. První ikona otevře nové 

okno map display a tím i novou záložku display s pořadovým číslem dvě. Druhá ikona 

načte mapové vrstvy do záložky Display 1, která se nachází pod tímto menu. Třetí ikona 
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otevře uložené zobrazení vrstev a jejich možnosti nastavení. Čtvrtá uloží zobrazení  

 

vrstev a jejich možnosti nastavení. Pátá přidá novou rastrovou mapu. Šestá otevře 

rozevírací menu, které obsahuje přidání rastrových vrstev s určitými vlastnostmi. Sedmá 

přidá novou vektorovou vrstvu. Osmá otevře rozevírací menu, které obsahuje přidání 

vektorových vrstev s určitými vlastnostmi. Devátá přidává vrstvu, v níž příkaz nebo 

seznam příkazů může být zadán. Desátá přidá prázdné vrstvy skupiny. Vrstvy pak 

mohou být přidány do skupiny. Jedenáctá Dvanáctá odebere vybranou vrstvu v záložce 

display. Třináctá otevře atributovou tabulku vybrané vrstvy.   

 

 
Obr. 1 Okno Správce vrstev 

Pod panelem Toolbar se nachází seznam mapových vrstev, kam se vytvářejí nové 

nebo načítají staré mapové vrstvy. U každé vrstvy je zaškrtávací políčko checkbox 

(nalevo), které aktivuje nebo inaktivuje mapovou vrstvu. Pouze aktivní vrstvy se zobrazí 

v okně Map display. 

 Posledním ovládacím prvkem je příkazová řádka označená Cmd >. Nachází se 

úplně dole, jak je patrné z Obr.1 
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Map display 

Map display je okno pro zobrazení jednotlivých mapových vrstev ze správce 

vrstev. Každé okno Map displeje má jedinečný seznam vrstev ve Správci vrstev. V horní 

části okna je panel nástrojů s tlačítky pro správu map na displeji. Panel je znázorněný 

na obr. Tento panel obsahuje funkce pro překreslování map, vymazání mapy z displeje, 

různé druhy zoomu. Dále obsahuje funkce měření vzdálenosti mezi dvěma body, profil 

mapy povrchu a umí vytvořit histogram obrazu nebo rastrového souboru. Aby se dalo 

v mapě bez problémů orientovat, tak tento panel obsahuje měřítko mapy se směrovou 

růžicí, legendu, a umí do mapy přidat text jako další vrstvu. Aby tyto úkony měly nějaký 

smysl, obsahuje tlačítko pro uložení kompozice displeje a tlačítko pro tisk mapy. Úplně 

posledním prvkem na panelu rozevírací menu pro výběr různých režim zobrazení. Tím 

první ze seznamu je 2D režim zobrazení. To znamená, že všechny aktivní vrstvy jsou 

složené a zobrazené ve 2D režimu.  

 

 
Obr. 2 Okno Map display 

 Dalším je 3D režim zobrazení je náhradou za Nviz. Zobrazí všechny aktivní 

vrstvy v 3D pohledu pomocí OpenGL. Po přepnutí se otevře nový ovládací panel, 
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kterým se dá dále upravovat otevřená 3D mapa a posledním z výběru zobrazení je 

digitalizovat. Okno Map displeje krom panelu nástrojů dále obsahuje Status bar, ve 

kterém si uživatel může zvolit zobrazení zeměpisných souřadnic pod kurzorem, oblast 

rozsahu mapy, výpočetní region, zobrazení geometrie mapy (počet řádků, sloupců, 

rozlišení) a měřítko mapy. Posledním a tím nejdůležitějším prvkem v okně Map displeje 

je samotný prostor k vykreslení příslušných map. 

 

1.2.2.2 Textová příkazová konzole 

Textová konzole umí pracovat s veškerými moduly a funkcemi, které program 

GRASS GIS obsahuje, jen za pomocí příkazů zadávaných do příkazového řádku.  Na 

Obr.3 je znázorněna textová konzole. Jedná se o stejné okno jako v případě Správce 

vrstev. Jedinou změnou tohoto okna je přepnutá záložka na Výstup příkazů. Tato 

záložka obsahuje tlačítka pro vymazání Výstupu příkazů (Clear) nebo jeho uložení.   
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Obr. 3 Okno Textové příkazové konzole 

 

Příslušné příkazy se zadávají do příkazové řádky, která je označena písmeny 

Cmd > a nachází se v okně pod záložkou Výstupu příkazů. Po napsání příkazu a 

stisknutí klávesy enter se provede příslušný příkaz.  

Například příkaz g.region vect=body_e@studenti –p nastaví výpočetní region 

podle vybrané mapy. g.region je program pro správu definice hranic geografického 

regionu, vect=body_e@studenti je název příslušné vektorové mapy a –p je zkratka pro 

výpis aktuálního regionu Výstupu příkazů.  

 

 

1.3 GMSH 

GMSH je generátor sítí konečných prvků se zobrazením v 1D, 2D i 3D prostoru. 

Jeho prvotním cílem je poskytnout jednoduchý nástroj pro akademické testovací případy 

s parametrickým vstupem a schopností vizualizace dat. Jednou z jeho předností je 

schopnost respektovat charakteristické velikosti polí a vygenerovat je v Mesh modulu 

pomocí linií, povrchů a objemů. GMSH obsahuje čtyři základní modul, kterými jsou 

Geometry, Mesh, Solver a post-processing. S těmito moduly se dá pracovat za pomoci 

grafického uživatelského rozhraní nebo v textových ASCII souborech pomocí vlastního 

skriptovacího jazyka, který GMSH používá(Christophe Geuzaine and Jean-Fran.cois 

Remacle, 2009). 

 

 

1.3.1 Práce se skriptovacím jazykem 

Nadefinování bodů (point) 

Tento příkaz nadefinuje jednoduchý prostorový bod (point). Za příkazovým 

slovem Point se nachází v závorce pořadové číslo prvku, označené písmenem p. Ve 

složených závorkách jsou souřadnice bodu označené písmeny x, y a z. Poslední parametr 

je pro hustotu sítě v daném okolí bodu.  

Point(p)  = {  x  ,  y  ,  z  ,  h  }; 
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Nadefinování linie (line) a splajny (spline)  

Za pomoci příkazu line se vytvoří linie (funguje pouze mezi dvěma body). 

Příkazem spline se vytvoří taktéž linie, ale tato linie se dá proložit více body. Tyto dva 

příkazy jsou prakticky totožné. V závorce za příkazovým slovem mají pořadové číslo 

prvku. Ve složených závorkách se nacházejí pořadová čísla prvků, mezi kterými se 

propojí linií nebo splajnou.    

 

Line(p) = {p1, p2 };   p1, p2, pn – jsou pořadová čísla point 

Spline(p) = {p1, … , pn}; 

 

Nadefinování povrchu 

Povrch v GMSH se dá nadefinovat pomocí dvou funkcí, Plane surface a Ruled 

surface. Plane surface potřebuje pro své úspěšné nadefinování povrchu mít okrajové 

body ve stejné rovině. Ruled surface si poradí i s body, které nejsou ve stejné rovině a 

tím i se zakřivenou plochou. 

 

Line Loop(p) = {p1, … , pn}; p1,pn – jsou pořadová čísla line nebo spline 

Plane surface(p) = {pLL};     pLL – je pořadové číslo Line Loop 

Ruled Surface(p) = {pLL};    

 

Nadefinování objemu (Volume) 

Objem se v GMSH nadefinuje výběrem povrchu ohraničující daný prostor. 

 

Surface Loop(p) = {p1, … , pn}; p1, pn - jsou pořadová čísla povrchů 

Volume(p) = {pSL};   pSL - je pořadové číslo Surface Loop 
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1.3.2 Práce s grafickým rozhraním 

 

 
Obr. 4 Grafické uživatelské prostředí  GMSH 

 

Grafické rozhraní v GMSH se skládá ze dvou hlavních oken. Z příkazového a 

zobrazovacího okna. V příkazovém okně se vybírají jednotlivé funkce pomocí tlačítek a 

hlavního rozbalovacího menu. Přepíná se v něm mezi jednotlivými moduly pomocí 

vysouvacího menu, které se nachází hned pod hlavním menu. V zobrazovacím okně se 

zobrazují data ze souboru, který se edituje pomocí skriptovacího jazyka nebo 

příkazového okna. Dále se v něm vybírají body, linie a povrchy, se kterými se dále 

pracuje. 

Na Obr.4 jsou znázorněna okna v GMSH. Malé okno vně velkého okna je 

příkazové okno a to velké okno zobrazovací okno.   
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1.4 3D modelování 

Všechny 3D geometrické modely jsou složeny z kombinací bodů, linií a 

polygonů. Každý 3D geometrický model má objem. To znamená, že každý bod modelu 

má tři souřadnice, vyjádřené většinou jako x, y, z. Tento matematický popis vyjadřuje 

geometrii skutečného světa, ve kterém se šířka, hloubka a výška s logickým důsledkem 

vlastností, jeví jako objem, hmotnost a těžiště.  

Výhody 3D modelování spočívají ve způsobu, jakým vidíme informace. 3D 

zobrazení je simulací prostorové reality, což umožňuje divákovi, aby rychleji rozpoznal 

a pochopil změny v krajině. Dokáže zobrazit a vygenerovat stromy, domy či dokonce 

sezónní charakteristiky počasí, jako je například sníh.  

Většina GIS softwarů je schopna zobrazit topografické data, jako digitální model 

terénu (DEM) a generovat izometrické pohledy a obrysy mapy. Mnoho produktů má 

také integrované 3D moduly pro vizualizaci dat.  

 

2 Praktická část 

Úkolem praktické části této bakalářské práce bude upravení dat v programu 

GRASS GIS a následné vytvoření 3D geometrického modelu území v generátoru sítí 

v programu GMSH. Nejprve bude zapotřebí vybrat data, která se budou hodit do 

modelované oblasti, protože v 3D geometrickém modelu bude vidět jen část z dat, se 

kterými se bude pracovat. Poté započne práce s programem GRASS GIS, se kterým se 

budou upravovat data pro 3D geometrický model. V programu GRASS GIS se nejprve 

vytvoří nová vrstva, která bude souhlasit s velikostí modelované oblasti. Poté se 

k daným vrstvám vytvoří a připojí atributové tabulky s parametry x, y a z. Následně se 

provedou interpolace jednotlivých vrstev modelované oblasti, aby se zjistily jednotlivé 

výšky vrstev a mohly se doplnit do atributových tabulek. Dalším krokem bude získání 

prostorových dat pro jednotlivé body modelované oblasti a následné doplnění těchto 

bodů do atributových tabulek. Posledním krokem v GRASS GIS bude vyexportování dat 

do externích souborů. 

Z vyexportovaných dat se vytvoří soubor, který půjde otevřít v programu GMSH. 

Po otevření souboru s daty, se zobrazí okrajové body modelované oblasti, se kterými se 

bude dále pracovat. Tyto body se pospojují liniemi. Nadefinují se povrchy a objemy 

v programu GMSH, aby se posléze mohl vytvořit 3D geometrický model.       
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2.1 Informace o území a datech 

V geografických datech pro tuto bakalářskou práci se nacházejí data modelované 

oblasti. V datech jsou uloženy informace o tomto místě. Obsahují souřadnice hraničních 

bodů výřezu s názvem zajmova_oblast. Tato oblast je znázorněna na Obr.5 jako světle 

šedý pětiúhelník. Dále obsahuje žulový masiv s názvem cert_zed. Znázorněný na Obr.5 

jako šedý čtyřúhelník. Žulový masiv z Obr.5 prochází pěti horizontálními vrstvami 

obsaženými taktéž v geografických datech.  

 

 
Obr. 5 Zájmová oblast s Čertovou zdí 

 

Těchto pět vrstev s názvy body_c, body_d, body_e, body_jil, body_turon je 

znázorněno na Obr.6 s povrchem s názvem body_povrch. Šířka jednotlivých vrstev je 

odlišná. Veškerá data, která byla v této podkapitole zmíněna. Jsou ve formátu 

vektorových dat. 
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Obr. 6 Názvy a rozmístění jednotlivých vrstev v zájmové oblasti 

 

Vrstva C začíná v nadmořské výšce 90 m (tj. zhruba 310 m pod povrchem) a je 

široká 35 m. Další navazující vrstvou je vrstva D, která navazuje asi ve 125 m (tj. asi 

275 m pod povrchem) a je široká 30 m. Po vrstvě D navazuje vrstva E s nadmořskou 

výškou 160 m (tj. asi 245 m pod povrchem) a je široká 60 m. Následuje vrstva Jíl se 

začátkem ve 230 m (tj. asi 185 m pod povrchem) a je široká zhruba 100 m. Poslední 

vrstvou je vrstva Turon, která začíná v nadmořské výšce 340 m (tj. asi 85 m pod 

povrchem) a je široká 65 m. Vrstvu Turon zakončuje Povrch s převýšením 120 m. 

 

 

2.2 Velikost modelované oblasti 

Dle zadání se modelovaná oblast zaměří jen na oblast čertovy zdi. To znamená, 

že v modelové oblasti bude čertova zeď ve všech pěti vrstvách a malí kousek okolí 

taktéž ve všech vrstvách. Velikost oblasti je znázorněna na Obr.7 čtyřmi červenými body 

spojenými červenými přímkami. 
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Obr. 7 Zájmová oblast 2 (červeně) 

2.3 Postup pro vytvoření nové vektorové vrstvy 

2.3.1 Výběr vhodných vrstev k digitalizaci 

Pro úspěšné vytvoření nové vektorové vrstvy je zapotřebí správného a 

přehledného pozadí pro digitalizaci. Tímto pozadím se rozumí vektorové vrstvy, které 

dopomohou ke správnému zadání ohraničujících bodů nové vektorové vrstvy. 

Touto vrstvou by měla být cert_zed, protože má být celá znázorněna v konečném 

výsledku a tou další může být zajmova_oblast.   

 

2.3.2 Digitalizace nové vektorové vrstvy 

Pomocí digitalizace se vytvoří nová vektorová vrstva s názvem zaj_oblast2. Tato 

vrstva bude tvořena čtyřmi body, které budou ohraničovat její území. 

Pomocí grafického uživatelského rozhraní:  

V hlavním menu vyberte: Vektor -> Vytvořit vektorovou mapu -> Digitalizovat 

vektorovou mapu (Vector -> Develop vector map -> Digitize vector map) 

Mělo by se objevit okno na Obr.8. Toto okno má většina modulů a funkcí. 

Obsahuje záložky, do kterých se zadávají počáteční informace a příkazy pro správné 

provedení jednotlivých úkonů. Počet záložek se může měnit v závislosti na druhu 

modulu nebo funkce.  
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Obr. 8 Okno pro vytvoření nové vrstvy pomocí digitalizace 

 V záložce:  

- Požadováno (Required) 

- Název vstupní vektorové mapy (Name of input vector map): 

zaj_oblast2 

- Volitelné (Optional) 

- Zaškrtnout Vytvořit nový soubor, pokud neexistuje (Create new file 

if it does not exist ) 

- Příkazy ze skupiny d.* pro vykreslení pozadí (bgcmd, string): d.vect 

map=zajmova_oblast@studenti;d.vect map=cert_zed@studenti 

 

Pomocí konzole: 

v.digit – n  map = zaj_oblast2 bgcmd = d.vect 

map=zajmova_oblast@studenti;d.vect map=cert_zed@studenti, kde v.digit je příkaz pro 

funkci digitalizace, -n vytvoří novou vrstvu a příkaz bgcmd zobrazí v tomto případě do 

pozadí příslušné vektorové vrstvy. Do pozadí může zobrazit i rastrovou vrstvu, tak že 

místo vect se zadá příkaz rast.  

Po těchto krocích by se měl otevřít toolbox s digitalizačním oknem, ve kterém by 

v pozadí měly být vektorové vrstvy zajmova_oblast a cert_zed. 
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Dalším krokem je zadání a vykreslení hraničních bodů v digitalizačním okně. 

Body se zadají a vykreslí pomocí tlačítka Digitize new point. Jeden po druhém se do 

vrstvy zanesou, tak aby nová vrstva zaj_oblast2 obsahovala celou Čertovu zeď. Při 

zadávání jednotlivých bodů se objevuje chybová hláška, protože není zatím 

nadefinována atributová tabulka. 

Po dokončení digitalizace mapy se provede uložení a ukončení vrstvy pomocí 

tlačítka Save and exit. 

 
Obr. 9 Zájmová oblast (světle šedivá), Čertova zeď (tmavě šedivá), Zájmová oblast 2 (červeně) 

 

 

2.4 Práce s atributovými tabulkami 

Ke každé vrstvě by měla být přiřazena atributová tabulka s prostorovými daty 

daných objektů nacházejících se ve vrstvě. Atributové tabulky jsou většinou 

pojmenovány po vrstvy, ke které se vztahují kuli přehlednosti, ale lze je i pojmenovat 

jinými názvy.    

Ze všeho nejdříve se odpojí atributová tabulka od vrstvy cert_zed, protože její 

atributová tabulka neobsahuje výškovou souřadnici. Poté se vytvoří nová tabulka pro 

vrstvy cert_zed a zaj_oblast2, která žádnou tabulku nemá. Obě atributové tabulky budou 

obsahovat parametr cat (pořadové číslo položky) a souřadnicové parametry (x, y, z). 
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2.4.1 Odpojení atributové tabulky od vrstvy 

V této podkapitole se odpojí atributová tabulka cert_zed od její vrstvy pomocí 

modulu v.db.connect, aby následně v dalším kroku mohla být vytvořena nová atributová 

tabulka a připojena ke stávající vrstvě cert_zed.  

 

Pomocí grafického uživatelského rozhraní:  

V hlavním menu vyberte: Databáze -> Databázové spojení -> Databázové 

spojení (Database -> Vector database connections -> Set vector map - database 

connections) 

 

V záložce:  

- Požadováno (Required) 

- Název vstupní vektorové mapy (Name of input vector map): cert_zed 

- Volitelné (Optional) 

- Zaškrtnout Vymaž připojení pro danou vrstvu (Delete connection for 

certain layer) 

- Jméno tabulky (Table name): cert_zed 

- Jméno sloupce s klíčem (Key column name): cat 

- Číslo vrstvy (Layer number): 1  

 

Pomocí konzole: 

v.db.connect –d map=cert_zed@studenti driver=dbf table=cert_zed key=cat 

layer=1 

 

2.4.2 Vytvoření nové atributové tabulky pro Čertovu zeď 

Tato atributová tabulka se bude jmenovat cert_zed_nova a bude připojena 

k vektorové vrstvě s názvem cert_zed. Atributová tabulka bude mít čtyři parametry. 

Třemi parametry jsou souřadnice x, y, z a tím čtvrtým parametrem bude cat, Kde cat je 

parametr pro pořadové číslo položky. 

 

Pomocí grafického uživatelského rozhraní:  

V hlavním menu vyberte: Databáze -> Správa tabulek -> Vytvořit tabulku 

 (Database -> Manage database -> New table) 
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V záložce:  

- Požadováno (Required) 

- Název vektorové vrstvy, pro kterou bude vytvořena atributová tabulka 

(Vector map for which to add new attribute table): cert_zed 

- Volitelné (Optional) 

- Název nové atributové tabulky (Name of new attribute table): 

cert_zed_nova 

- Vrstva, ve které bude nová atributová tabulka přidána(Layer where to 

add new attribute table):1 

- Názvy a typy nových sloupců (Name and type of the new columns): 

cat interger, x double, y double, z double  

 

Pomocí konzole: 

v.db.addtable map=cert_zed@studenti table=cert_zed_nova layer=1 columns=cat 

integer,x double,y double,z double 

 

Správné vytvoření a zároveň připojení atributové tabulky k vrstvě 

cert_zed@studenti vyplyne ze záložky Výstupu příkazů v okně modulu v.db.addtable. 

V záložce by se mělo objevit o správném vytvoření atributové tabulky s názvem 

cert_zed_nova a následně by se mělo objevit i správné propojení s vektorovou vrstvou 

cert_zed@studenti. 

 

 

2.4.3 Vytvoření nové atributové tabulky pro modelovanou oblast 

Tato atributová tabulka se bude jmenovat zajm_oblast2 a bude připojena 

k vektorové vrstvě se stejným názvem. Atributová tabulka bude mít taktéž čtyři 

parametry a budou úplně stejné jako v předchozím případě.  

 

Pomocí grafického uživatelského rozhraní:  

V hlavním menu vyberte: Databáze -> Správa tabulek -> Vytvořit tabulku 

 (Database -> Manage database -> New table) 
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V záložce:  

- Požadováno (Required) 

- Název vektorové vrstvy, pro kterou bude vytvořena atributová tabulka 

(Vector map for which to add new attribute table): zajm_oblast2 

 

- Volitelné (Optional) 

- Název nové atributové tabulky (Name of new attribute table): 

zajm_oblast2 

- Vrstva, ve které bude nová atributová tabulka přidána(Layer where to 

add new attribute table):1 

- Názvy a typy nových sloupců (Name and type of the new columns): 

cat interger, x double, y double, z double  

 

Pomocí konzole: 

v.db.addtable map=zajm_oblast2@studenti table=zajm_oblast2 layer=1 

columns=cat integer,x double,y double,z double 

 

Obě atributové tabulky lze zobrazit. V grafickém uživatelském prostředí se dají 

zobrazit, tak že se ve Správci vrstev vybere příslušná vrstva pravým tlačítkem myši a 

otevře menu. Vybere Zobrazit atributovou tabulku nebo za pomoci tlačítka Zobrazit 

atributovou tabulku ve Správci vrstev v toolbaru. V textové konzoly za pomoci příkazu 

db.select table=nazev_tabulky. Vypíše do záložky Výstupu příkazů celou atributovou 

tabulku.  

 

2.5 Interpolace povrchu 

Pomocí interpolace se získají výšky povrchu jednotlivých vrstev k dalšímu 

zpracování. V každém souboru vrstvy se nachází zetová souřadnice s názvem Z krom 

souboru body_jil, kde tato souřadnice je nazvána Z1. Souřadnice poslouží k dopočítání 

výšek pro celou modelovou oblast. 

 

Pomocí grafického uživatelského rozhraní:  

V hlavním menu vyberte: Rastr -> Interpolovat povrch -> Interpolace IDW 

z vektorových bodů (Raster -> Interpolate surface -> IDW from vector points) 
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V záložce:  

- Požadováno (Required) 

- Název vstupní vektorové mapy (Name of input vector map): 

body_povrch 

- Název výstupní rastrové mapy (Name for output raster map): 

interpolace_povrch 

- Volitelné (Optional) 

- Počet bodů pro interpolaci (Name of interpolation points): 200 

- Číslo vrstvy (Layer number):1 

- Sloupec tabulky atributů s hodnotami pro interpolaci (Attribute table 

column with values to interpolate): Z  

 

Pomocí konzole: 

v.surf.idw input=body_povrch@studenti output=interpolace_povrch npoints=200 

layer=1 column=Z 

 
Obr. 10 Interpolace povrchové vrstvy body_povrch s převýšením 209 metrů 

Za pomoci tohoto modulu byly vytvořeny interpolace pro vrstvy s názvem 

body_c, body_d, body_e, body_jil, body_turon a body_povrch. Příslušným interpolacím 

byly přiřazeny názvy interpolace_c, interpolace_d, interpolace_e, interpolace_jil, 

interpolace_turon a interpolace_povrch. Počet interpolačních bodů byl stanoven podle 

počtu bodů v atributových tabulkách příslušných vrstev. V tomto případě jich bylo dvě 

stě.  
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2.6 Vytvoření 3D vektoru nad rastrem 

Aby bylo možné v dalším kroku dopočítat atributová data do tabulek. Musí se 

vytvořit 3D vektor za pomoci rastrových vrstev z předchozí kapitoly, ze kterého se poté 

data doplní do atributových tabulek. Tyto prostorové vektory se vytvoří pro všechny 

vrstvy Zájmové oblasti 2 a Čertovi zdi. 

   

Pomocí grafického uživatelského rozhraní:  

V hlavním menu vyberte: Vektor -> Vytvořit novou mapu -> Vytvořit 3D vektor 

nad rastrem (Vector -> Develop map -> Create 3D vector over raster) 

 

V záložce:  

- Požadováno (Required) 

- Název vstupní vektorové mapy (Name of input vector map): 

zajm_oblast2 

 

- Název výstupní vektorové mapy (Name for output vector map): 

zajm_oblast2_povrch 

- Volitelné (Optional) 

- Rastrová mapa elevace pro extrakci výšek (Elevation raster for height 

extraction): interpolace_povrch 

- Typ vzorkování (Sampling method): nearest 

- Číslo vrstvy (Layer number): 1 

- Typy vektorových prvků (Object vectors types): point V tomto 

konkrétním případě stačí vybrat jen bod (point), protože data 

obsahují jen body. V jiných případech se dá vybrat centroid, line, 

boundary, face, kernel 

 

Pomocí konzole: 

v.drape input=zajm_oblast2@studenti type=point rast=interpolace_povrch 

method=nearest output=zajm_oblast2_povrch 
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2.7 Dopočítání dat do atributových tabulek 

K další práci je zapotřebí dopočítat souřadnice do atributových tabulek za 

pomoci modulu v.to.db. Atributové tabulky se budou dopočítávat pro všechny vrstvy 

Zájmové oblasti 2 a Čertovi zdi. 

 

Pomocí grafického uživatelského rozhraní:  

V hlavním menu vyberte: Vektor -> Zprávy, výpisy a statistiky -> Načíst nebo 

podat zprávu o topologii (Vector -> Report and statistics -> Upload or report topology) 

V záložce:  

- Požadováno (Required) 

- Název vstupní vektorové mapy (Name of input vector map): 

zajm_oblast2_povrch 

- Hodnota pro aktualizaci (Value for the update): coor 

- Volitelné (Optional) 

- Název sloupců atributové tabulky (Name column attribute table): x, y, 

z 

- Číslo vrstvy (Layer number): 1 

 

Pomocí konzole: 

v.to.db map=zajm_oblast2_povrch option=coor col=x,y,z 

Zajm_oblast2_povrch je název mapy, ke které se dopočítávají souřadnice do 

atributové tabulky. Parametr coor neboli coordinate značí souřadnice a parametr col 

udává, které sloupce se dopočtou do atributové tabulky.    

 

2.8 Export dat 

Jelikož modelovaná oblast bude zobrazena v programu GMSH. Musí se data 

vyexportovat z databáze GRASSu a dále upravit, aby byly správně zobrazeny v GMSH. 

GMSH pracuje se soubory *geo, a proto nejdou použít data ve formátu, který používá 

GRASS GIS. 

Za pomoci modulu v.out.ascii se vyexportují atributové tabulky, které půjdou 

otevřít v jakémkoli tabulkovém editoru. Tabulky se vyexportují pro všechny vrstvy ze 

Zájmové oblasti 2 a Čertovi zdi. 
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Pomocí grafického uživatelského rozhraní:  

V hlavním menu vyberte: Soubor -> Export vektorové mapy -> Export ASCII 

bodů / GRASS ASCII vektorů (File -> Export vector map -> ASCII points or GRASS 

ASCII vector) 

 

V záložce:  

- Požadováno (Required) 

- Název vstupní vektorové mapy (Name of input vector map): 

zajm_oblast2_povrch 

- Body (Points) 

- Oddělovač sloupců (Separator columns): tab 

- Počet míst za desetinou čárkou (Number of places for floatin point): 8 

- Volitelné (Optional) 

- Cesta k výslednému souboru ASCII nebo jméno ASCII vektoru, 

pokud je zadána: C:\“cesta“\zajm_oblast2_povrch.xls 

- Výstupní formát (Output format): point 

 

Pomocí konzole: 

v.out.ascii input=zajm_oblast2_povrch@studenti {C:\“cesta“\ zajm_oblast2_ 

povrch.xls} format=point fs=tab db=8 

Zajm_oblast2_povrch@studenti je název vrstvy, ze které se exportují data do 

externího souboru. {C:\“cesta“\ zajm_oblast2_ povrch.xls} je cesta, kam se uloží soubor 

s exportovanými daty. Parametr point vypíše do externího souboru jen body z atributové 

tabulky. Funkce fs definuje oddělovací znak od jednotlivých souřadnic a poslední funkcí 

je db, která umožní uživateli zvolit, kolik číslic bude za desetinou čákou.  

 

2.9 Vytvoření 3D geometrického modelu oblasti v GMSH 

Nejprve z vyexportovaných dat z GRASS GIS se upraví a vytvoří soubor 

s koncovkou *.geo, který GMSH umí otevřít a dále s ním pracovat. Jelikož jsou 

vyexportovaná data jen samé prostorové body, tak dalším krokem bude tyto body 

pospojovat splajnami a liniemi v GMSH. Poté se musí nadefinovat povrchy a objemy, 

aby se následně mohl vytvořit 3D geometrický model příslušné modelované oblasti.   
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2.9.1 Vytvoření geo souboru 

Vyexportovaná data z GRASS GIS jsou obsažena ve vícero souborech. Aby 

GMSH zobrazil celou modelovanou oblast je zapotřebí nakopírovat data z jednotlivých 

souborů do jediného souboru s koncovkou geo a upravit data tak, jako je to v Tab.1. 

V tomto případě byl použit pro úpravu soboru s koncovkou geo poznámkový blok. 

 
Tab. 1  Obsah geo souboru 

x =100; 
y =40; 
//zajm_oblast2 vrstva c 
Point(1)  = {-694547.43671021 , -981537.592175     , 97.05057149   ,  x }; 
Point(2)  = {-695737.3985999   ,  -980250.0924255   , 119.86670944 ,  x }; 
Point(3)  = {-699619.40542036 , -985380.58385153 , 89.51856764   ,  x }; 
Point(4)  = {-700536.26130258 , -984171.11438988 , 108.3237353   ,  x }; 
//cert_zed vrstva c 
Point(6)  = {-695753.8509693   , -980590.05538257 , 117.83437338 ,  y }; 
Point(7)  = {-694890.60128821 , -981515.59936187 , 98.60891185   ,  y }; 
Point(8)  = {-699635.04349414 , -985030.99280512 , 92.58834612   ,  y }; 
Point(9)  = {-700207.34097747 , -984179.25802924 , 107.66691886 ,  y }; 
//zajm_oblast2 vrstva d 
Point(11) = {-694547.43671021 , -981537.592175     , 138.40497163 ,  x }; 
Point(12) = {-695737.3985999   , -980250.0924255   , 155.31382638 ,  x }; 
Point(13) = {-699619.40542036 , -985380.58385153 , 125.4329371   ,  x }; 
Point(14) = {-700536.26130258 , -984171.11438988 , 137.95886124 ,  x }; 
//cert_zed vrstva d 
Point(16) = {-695753.8509693   , -980590.05538257 , 154.89594689 ,  y }; 
Point(17) = {-694890.60128821 , -981515.59936187 , 139.65496611 ,  y }; 
Point(18) = {-699635.04349414 , -985030.99280512 , 129.07635504 ,  y }; 
Point(19) = {-700207.34097747 , -984179.25802924 , 137.59387532 ,  y }; 
//zajm_oblast2 vrstva e 
Point(21) = {-694547.43671021 , -981537.592175     , 170.64561174 ,  x }; 
Point(22) = {-695737.3985999   , -980250.0924255   , 190.0998921   ,  x }; 
Point(23) = {-699619.40542036 , -985380.58385153 , 155.98028477 ,  x }; 
Point(24) = {-700536.26130258 , -984171.11438988 , 171.50557758 ,  x }; 
//cert_zed vrstva e 
Point(26) = {-695753.8509693   , -980590.05538257 , 188.30704855 ,  y }; 
Point(27) = {-694890.60128821 , -981515.59936187 , 171.90776596 ,  y }; 
Point(28) = {-699635.04349414 , -985030.99280512 , 158.58205648 ,  y }; 
Point(29) = {-700207.34097747 , -984179.25802924 , 170.98586946 ,  y }; 
//zajm_oblast2 vrstva jil 
Point(31) = {-694547.43671021 , -981537.592175     , 230.645474     ,  x }; 
Point(32) = {-695737.3985999   , -980250.0924255   , 250.1001663   ,  x }; 
Point(33) =  {-699619.40542036 , -985380.58385153 , 215.98018154 ,  x }; 
Point(34) = {-700536.26130258 , -984171.11438988 , 231.50550092 ,  x }; 
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//cert_zed vrstva jil 
Point(36) = {-695753.8509693   , -980590.05538257 , 248.30675262 ,  y }; 
Point(37) = {-694890.60128821 , -981515.59936187 , 231.90758218 ,  y }; 
Point(38) = {-699635.04349414 , -985030.99280512 , 218.58207946 ,  y }; 
Point(39) = {-700207.34097747 , -984179.25802924 , 230.98578716 ,  y }; 
//zajm_oblast2 vrstva turon 
Point(41) = {-694547.43671021 , -981537.592175     , 347.0922443   ,  x }; 
Point(42) = {-695737.3985999   , -980250.0924255   , 352.36336738 ,  x }; 
Point(43) = {-699619.40542036 , -985380.58385153 , 346.65925214 ,  x }; 
Point(44) = {-700536.26130258 , -984171.11438988 , 350.86789439 ,  x }; 
//cert_zed vrstva turon 
Point(46) = {-695753.8509693   , -980590.05538257 , 351.82869177 ,  y }; 
Point(47) = {-694890.60128821 , -981515.59936187 , 347.40756965 ,  y }; 
Point(48) = {-699635.04349414 , -985030.99280512 , 347.52427579 ,  y }; 
Point(49) = {-700207.34097747 , -984179.25802924 , 350.73587224 ,  y }; 
//zajm_oblast2 vrstva povrch 
Point(51) = {-694547.43671021 , -981537.592175     , 400.01054044 ,  x }; 
Point(52) = {-695737.3985999   , -980250.0924255   , 467.94448231 ,  x }; 
Point(53) = {-699619.40542036 , -985380.58385153 , 382.97024636 ,  x }; 
Point(54) = {-700536.26130258 , -984171.11438988 , 399.98591753 ,  x }; 
Point(55) =  {-695311.01647056 , -980702.86447325 , 456.5288         ,  x }; 
Point(56) =  {-694904.6601841   , -981145.07572616 , 411.88755882 ,  x }; 
Point(57) =  {-695311.01647056 , -981061.41413777 , 433.21219662 ,  x }; 
Point(58) =  {-695095.88667184 , -981981.69161004 , 391.24324647 ,  x }; 
Point(59) =  {-695753.22772346 , -982471.70948488 , 433.61788277 ,  x }; 
Point(60) =  {-696482.27870799 , -983021.48563715 , 449.61352747 ,  x }; 
Point(61) =  {-697187.42638154 , -983559.31013393 , 447.45953888 ,  x }; 
Point(62) =  {-697976.23564349 , -984144.94125264 , 449.90227414 ,  x }; 
Point(63) =  {-698836.75483834 , -984802.28230426 , 406.09853414 ,  x }; 
Point(64) =  {-695550.04958024 , -982017.54657649 , 426.4185916   ,  x }; 
Point(65) =  {-696255.19725379 , -982531.4677623   , 449.85866728 ,  x }; 
Point(66) =  {-696936.44161638 , -983045.38894811 , 449.56218565 ,  x }; 
Point(67) =  {-697713.29922284 , -983619.06841135 , 449.82158865 ,  x }; 
Point(68) =  {-698537.96345124 , -984228.60284103 , 431.14555466 ,  x }; 
Point(69) =  {-696410.56877508 , -980822.38102809 , 451.63067252 ,  x }; 
Point(70) =  {-697294.9912809   , -981563.3836681   , 447.8913858   ,  x }; 
Point(71) =  {-698227.22040865 ,  -982304.38630811 , 412.97630432 ,  x }; 
Point(72) =  {-699362.62767963 , -983224.66378037 , 402.73534796 ,  x }; 
Point(73) =  {-696661.55354025 , -981324.35055842 , 447.90442354 ,  x }; 
Point(74) =  {-697593.782668     , -982077.30485391 , 448.4050078   ,  x }; 
Point(75) =  {-699804.83893254 , -983858.10152103 , 378.65452699 ,  x }; 
Point(76) =  {-700079.72700867 , -984790.33064878 , 350.00613569 ,  x }; 
Point(77) =  {-698693.33497253 , -982961.72735973 , 401.82932193 ,  x }; 
//cert_zed vrstva povrch 
Point(78) = {-695753.8509693   , -980590.05538257 , 469.4948011   ,  y }; 
Point(79) = {-694890.60128821 , -981515.59936187 , 404.32962541 ,  y }; 
Point(80) = {-699635.04349414 , -985030.99280512 , 366.92035706 ,  y }; 
Point(90) = {-700207.34097747 , -984179.25802924 , 396.85675238 ,  y }; 
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Tabulka obsahuje upravená data pro další použití v GMSH. Na začátku tabulky 

jsou uvedeny proměnné x a y, které slouží ke snadnému měnění hustoty sítě pro 

modelovanou oblast. Hustota sítě se uvádí jako poslední ze čtyř parametrů příkazu pro 

vytvoření nového bodu v GMSH(například Point(1)  = {-694547.43671021 , -

981537.592175     , 97.05057149   ,  x }; ). Dále tabulka obsahuje příkazy k vytvoření 

bodů v GMSH. Pro přehlednost jsou odděleny komentáři, které se vytvářejí pomocí //.  

 

2.9.2 Otevření geo souboru v GMSH  

Po správné úpravě exportovaných dat do geo souboru se otevře v GMSH. Po 

otevření souboru se v okně vykreslí body ze souboru (Tab.1), se kterými se dále bude 

pracovat. Vykreslené body jsou vidět na Obr.11 zeleně.  

Postup: 

V příkazovém okně (to je to menší) v hlavním menu: File -> Open -> Cesta 

k souboru 

 
Obr. 11 Data z geo souboru zobrazená v GMSH 



37 

2.9.3 Propojení bodů pomocí splajn a linií 

Nejvrchnější vrstva obsahuje dvacet šest bodů Zajmové oblasti 2 a čtyři body 

Čertovy zdi, kvůli přesnějšímu vymodelování povrchu oblasti. Ostatních pět vrstev 

obsahuje pouze čtyři body Zájmové oblasti 2 a čtyři body Čertovy zedi. Povrchové body 

budou spojeny funkcí Spline a ostatní body z nižších vrstev budou spojeny funkcí 

Straight line. 

 

Tvorba Spline  

Postup: 

V příkazovém okně 

-  Ve vysouvacím menu: Geometry 

- Tlačítka: Elementary entities -> Add -> New -> Spline 

V zobrazovacím okně se vyberou body, kterými bude proložena splajna a stiskne 

se e pro vytvoření splajny. Funkce Spline proloží body zakřivenou linii, tak aby 

neobsahovala žádnou ostrou hranu. 

 

Tento úkon lze udělat i v geo souboru za pomoci příkazu Spline(1) = {51, 56, 55, 

52};. Tento příkaz proloží linii body 51, 56, 57 a 52. 

 

Tvorba Straight line  

Postup: 

V příkazovém okně 

-  Ve vysouvacím menu: Geometry 

- Tlačítka: Elementary entities -> Add -> New -> Straight line 

V zobrazovacím okně se vyberou dva body, které se mezi sebou spojí linií. 

 

Tento úkon lze udělat i v geo souboru za pomoci příkazu Line(30) = {52, 42};. 

Tento příkaz proloží linii body 52 a 42. 

 

Výsledek těchto dvou funkcí by měl vypadat jako na Obr.12   
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Obr. 12 Proložení bodů liniemi 

 

 

 

2.9.4 Nadefinování povrchů 

Pro vytvoření 3D geometrického modelu v GMSH je nejprve zapotřebí 

nadefinovat všechny povrchy, které vznikly z předchozího kroku. Tyto povrchy se 

nedefinují pomocí funkce Ruled surface. Ruled surface je funkce, které nevadí velké 

rozdíly hodnot mezi prostorovými souřadnicemi, proto je tato funkce vhodná pro 

nadefinování povrchů tohoto modelu. 

 

Postup: 

V příkazovém okně 

-  Ve vysouvacím menu: Geometry 

- Tlačítka: Elementary entities -> Add -> New -> Ruled surface 

V zobrazovacím okně se vyberou linie, které ohraničují příslušný povrch. Po 

vybrání všech linií se stiskne e pro provedení úkonu. Na povrchu by se měl objevit 

čerchovaný kříž.  
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Tento úkon lze provést i v geo souboru za pomoci příkazů Line Loop(13) = 

{2,7,11,9};, který do sebe zaindexuje linie a  Ruled Surface(14) = {13};, který 

nadefinuje povrch. 

 

2.9.5 Nadefinování objemů 

Postup: 

V příkazovém okně 

-  Ve vysouvacím menu: Geometry 

- Tlačítka: Elementary entities -> Add -> New -> Volume 

V zobrazovacím okně se vyberou povrchy, které ohraničují příslušný objem. Po 

vybrání všech povrchů se stiskne e pro provedení úkonu. 

 

Tento úkon lze provést i v geo souboru za pomoci příkazů Surface Loop(165) = 

{63,26,51,67,73};, který do sebe zaindexuje povrchy a  Volume(166) = {165};, který 

nadefinuje Objemy. 
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2.9.6 Zobrazení 3D modelu v GMSH 

Postup: 

V příkazovém okně 

-  Ve vysouvacím menu: Mesh 

- Tlačítka: 3D 

 

 
Obr. 13 3D geometrický model území vytvořený v GMSH 
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Závěr  

Díky této bakalářské práci jsem se seznámil s problematikou výstavby 3D 

modelů krajin z geografických dat. Naučil jsem se pracovat s geografickým programem 

GRASS GIS a také s programem GMSH pro tvorbu trojrozměrných geometrických 

modelů. Program GRASS GIS mi v této bakalářské práci posloužil pro výběr části území 

z oblasti, která byla zahrnuta v příslušných geografických datech. Dále jsem se naučil 

v tomto programu přidávat a odebírat atributové tabulky k vrstvám, interpolovat, 

dopočítávat souřadnice a vkládat je do atributových tabulek. Také jsem se naučil upravit 

data, tak aby je otevřel program GMSH a následně s nimi mohl pracovat. V programu 

GMSH se mi podařilo upravit data, tak abych vytvořil trojrozměrný geometrický model 

nazvaný Zájmová oblast 2. Tento model jsem vytvořil v GMSH za pomoci linií, které 

propojily body vyexportované z programu GRASS GIS a také nadefinováním povrchů a 

objemů modelu. 

Tato bakalářská práce by šla rozšířit o vytvoření dalšího 3D modelu se stejnými 

počátečními daty v jiném geografickém programu pro tvorbu 3D modelů a poté tyto dva 

modely porovnat mezi sebou.   
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